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The OS X file system is based on extensions to the BSD Unix file system 
with a VFS (Virtual Files System) design which allows for stacking of file 
systems, and supports both aliases and symbolic links.

Filenames
Can be 255 characters long. Do not begin a file name with a period, and avoid colons and slashes 
in a file name (slashes are used to designate folders or directories, e.g. /Applications/
Utilities). For cross-platform use you may have to shorten the length of a file name and remove 
blank spaces. 

Alias
A reference to a specific named file. They will follow a file wherever it is moved, as long as the 
name is not changed. They can be created in the Finder with the Make Alias command in the 
File menu (Command and F), or by holding Option and Command while dragging a file.

Symbolic Link
A Unix reference to a specific named file. If you move a file without replacing it with a file with 
the identical name, a symbolic link will break, unlike an alias.

Directory
Information as to the numbers, names, locations, types, and sizes of all files and folders saved on a 
disk volume is stored in a structured central directory. Computer crashes, resets, brownouts and 
power failures can cause directory damage. Journaled file systems (including OS X 10.4) keep a 
backup record of changes to a disk, and are less prone to suffering directory damage. Disk 
Utility (free) or DiskWarrior (commercial) may be able to repair a damaged directory.

Macintosh OS X File System
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Mac OS Extended Format (Journaled)
Also known as Journaled HFS+, this is a version of Macintosh Extended Format that is 
journaled to protect the integrity of the file system in the event of unplanned shutdowns or power 
failures. It is the default format used by Macintosh OS X 10.4 and up.

Mac OS Extended Format
Also known as Heirarchical File System Plus (HFS+) this is a version of the older 
Macintosh HFS format, extended to more flexibly handle data stored on large hard disks. It is the 
default format used by Macintosh OS 8.1, OS 9 and older versions of OS X. The original HFS was 
the standard format for Mac OS prior to 8.1. HFS supports files with data and resource forks.

NTFS
The standard file system of Windows NT and later. Macs can usually read, but not write to it.

MS-DOS File System (FAT, FAT32)
The file system used by MS-DOS and Windows computers. Macs can read and write it. 4 GB files.

Unix File System (UFS) 
A format based on the 4.4 BSD Unix FFS (Fast File System) that is similar to the standard volume 
format of most Unix operating systems. 

Universal Disk Format (UDF)
The standard cross-platform format for DVD volumes.

ISO 9660 
The standard cross-platform format for CD-ROM volumes.

Macintosh OS X Supported 
Volume Formats
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Macintosh OS X File and
Application Structure

A Macintosh OS X application can have a fairly complex structure. What appears to be a single file 
will generally have at least metadata and a data fork, and possibly a resource fork. 

Further, most OS X applications are actually bundles. A bundle is a folder which has had a 
bundle bit set such that the Finder displays it as a single application. This is also known as a 
package. A bundle actually contains multiple files, each with their own resource and data fork. It is 
possible to view the contents of a bundle by Control clicking it in the Finder, then selecting 
Show Package Contents.

As a result, moving a Macintosh application across platforms, or via email, can be tricky, as metadata 
and resource forks may be lost. This is why it is important to use an application such as Mail, which 
is aware of the Macintosh file structure, when emailing files, or use a disk imaging utility such as 
Disk Copy (.dmg), or a compression utility, such as Archive (.zip), compress (.z), gzip (.gz) or 
Stuffit Deluxe (.sit), all of which can convert an application into a single file with only a data fork.

File (HFS/HFS+)
Data Fork

Resource Fork

Metadata
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Macintosh OS X and Unix File 
Ownership and Permissions

Permissions and ownership information 
can be viewed (and changed) for a given 
file in the Finder by selecting Get Info 
from the File menu, then expanding the 
Ownership & Permissions section.

In general, one should not change these 
values. Disk Utility can repair common 
permission problems.

One can also lock and unlock a file or 
disk images from Get Info to temporarily 
create a read only file or volume. It is 
also possible to create a read only disk 
image (.dmg) in Disk Utility by changing 
the preferences.

In Unix, file permissions are commonly 
noted in the order: owner, group, 
other.  Thus, a file with permissions 
755 can be read, written and executed 
by the owner, but only read and 
executed by members of the group or 
others. The chmod command is used 
to change permissions.

File Permission Mappings

File Ownership
A file is typically owned by the account that 
created it. There are three levels of file access: 
owner, group and other. Each can have 
different levels of access. A user can belong to 
more than one group, and a file can have more than 
one owner, with different access levels for each. 
The default group in OS X is staff. Users with 
administrative privileges also belong to the group 
admin.



Lecture 3
Macintosh OS X
and Unix
October 8, 2009

Common 
File Extensions

File Extension
A three letter extension following a period at the end of a file name which indicates what 
type of document it is. It is one of the factors (metadata is another) that governs which 
application the Finder will use to open a file (this can be set under File > Get Info > 
Open With ). 

Text (Plain text)	 	 	 	 	 	 	 	 	 .txt
Based on the ASCII (American Standard Code for Information Interchange) or Unicode 
standards for exchanging plain text information. Macintosh text files use a slightly different 
system of line breaks from Unix or Windows, although most software compensates for it.

Word (Word processing)	 .doc
The industry standard for word processing. Works well with EndNote to handle citations 
to references. More compatible than the newer .docx format.

Excel (Spreadsheet)	 .xls
The industry standard for spreadsheets. Capable of sophisticated charting and graphing as 
well, though it requires some effort. More compatible than the newer .xlsx format.

PowerPoint (Presentations) 	 .ppt
The industry standard for presentations. On the Macintosh OS X platform, has competition 
from Apple’s Keynote (.key).

PDF (Portable Document Format)	 .pdf
A high quality cross platform bitmap and vector graphics format that is native to OS X, and 
ideal for distributing complex figures or papers. Any document in OS X can be saved in 
PDF format by first selecting Print from the File menu, then clicking Save As PDF...
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GIF (Graphics Interchange Format)	 .gif
A graphics file format optimized for onscreen viewing. Images are automatically compressed using 
a lossless compression scheme, and decent compression can be achieved for line art images, or 
images with few colors.

JPEG (Joint Photographic Experts Group)	 .jpg
A graphics file format based on lossy compression. It works particularly well with photographs, 
often reducing them to a tenth of their former size, but it does so by irrevocably discarding some 
data. Thus, one should be cautious when using this format with critical data.

TIFF (Tagged Image File Format)	 .tif
The industry standard for displaying and printing bitmapped images. It supports lossless compression.

EPS (Encapsulated PostScript)	 .eps
A format that can store both bitmapped and vector based information, making it suitable for very 
high resolution printing of text or figures.

PICT (Picture)	 .pct       or  BMP (Bitmap)                  .bmp
Older Macintosh (PICT) and Windows (BMP) graphics standards.

PNG (Portable Network Graphic)	 .png
A new, royalty free standard for onscreen viewing which has some benefits over the GIF format.

RAW (Raw data)	 .raw
An option on many digital cameras and microscopes, it gives the raw, uncorrected, uncompressed 
data.

Graphics
File Formats
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Classic (68K or PPC)
An application developed for an earlier version of the Mac OS which can run in Classic emulation 
in OS X. A 68K application does not take advantage of the faster PowerPC architecture, while a 
PPC application will do so.
Example: DNA Strider

Carbon
Typically an application developed for an earlier version of the Mac OS or other operating 
system, then brought up to date for OS X by “Carbonizing” it. It will run native under OS X, faster 
than a Classic application, and may also run in OS 9 or earlier.
Examples: Microsoft Office, EndNote

Cocoa
An application developed specifically for OS X. It will run native under OS X, but will not run on 
earlier versions of the Mac OS. In general, this type of application is the fastest under OS X.
Examples: Lab Assistant, EnzymeX, 4Peaks

Java
An application developed in the cross-platform Java programming language. It will run native under 
OS X, but can be a bit slow, and the need for compatibility can limit its graphical user interface.
Example: Sequence Analysis, JImage

Unix
An application developed for Unix that has been compiled to run under OS X’s BSD style Unix. It 
will typically have a command line interface, meant to be run by a user from a Unix command 
line, which Terminal gives access to in OS X.
Examples: seqstat, clustalw

Types of Macintosh OS X
and Applications
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Publishing Papers
Word, EndNote

Preparing Figures
Photoshop, Excel, OmniGraffle, DeltaGraph, Canvas, Illustrator

Presentations
PowerPoint, Keynote

Lab Notebooks
Word, TextWrangler, BBEdit, LabAssistant, FileMaker Pro

Lab Databases
EndNote, FileMaker Pro, iPhoto

Sequence Editing and Analysis
DNA Strider, Sequence Analysis, MacVector,TextWrangler, BBEdit, ClustalX, 4Peaks, Safari

Lab Utilities
DNA Artist, EnzymeX, JImage, LabAssistant

Macintosh OS X  Applications 
in Biology
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Organizing Files and Folders
1) Use nested folders of aliases in your home directory (i.e. ~/Aliases/Applications, 

~Aliases/Internet, ~/Aliases/Utilities) to organize aliases. Then drag the Aliases 
folder to your Dock.

2) Drag commonly used applications to your Dock.

3) Drag commonly used volumes and folders to the Sidebar. This will also add those volumes 
and folders to all Save and Save As... dialogue boxes, resulting in much easier navigation.

4) Customize your Toolbar by selecting Customize Toolbar... from the View menu to add a Path 
icon, which will help you find your current location (or Command click on the folder 
icon in the Toolbar).

5) Learn to drag files and folders to the Terminal window to quickly get their paths when using 
the command line.

6) Learn to use keyboard shortcuts when navigating. Examples include Command Shift N to 
create a new folder, Command Option drag or Command L to make an alias, using  
Command Tab to switch between applications, Command S to save, Command P to 
print, Command Delete to move files to the Trash, or using the Tab, arrow and other 
keys in the Save and Save As... dialogue boxes.

Macintosh OS X 
Organization and  Navigation
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Terminal
Terminal, located in /Applications/Utilities, is the application which gives an OS X user command 
line shell access to the underlying Unix operating system. One can drag a folder or application to 
the Terminal window to get its pathname, which is often required when issuing Unix commands.

ls (list)
Lists the current directory’s contents. Adding the -a option (ls -a) lists all contents, including what is normally 
invisible (file or directory names starting with a period, e.g. .bash_profile, are normally invisible). Adding the -l 
option (ls -l) lists long information about files: type, permissions, links, owner, group, size, modification date & 
time and name. The wild card character (*) is often useful in arguments for this command, e.g. ls *.doc will list 
all Word files with that extension in a directory.

cd (change directory)
By itself, cd takes you to your home directory. Using an argument of two periods, i.e. cd .., moves you to the 
directory directly above the current directory, while cd / moves you to the root directory. If you get lost, type 
pwd to print your working directory, that is, list your current directory as a pathname.

mv (move)
Copies the specified file(s). For more information on the syntax, type man mv to see the manual page for mv 
(when reading a manual page, press the space bar to page down, press q to quit the manual page).

rm (remove)
Removes/deletes the specified file(s). This command should be used with great precision, particularly when combined 
with wild card characters. A single typo can accidentally delete important files. The -i option (rm -i) runs rm in 
interactive mode, where it will ask if you really want to delete each file. Type man rm for more information.

sudo (superuser do)
Allows you to execute a single command as a root user, or superuser, who has no limitations. This command also 
has the potential to cause serious problems, so use it with care and precision.

exit
Type exit to logout of a Terminal session.

Terminal and the Unix 
Command Line
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Automation
in OS X or Unix

Automation
One of the tasks computers are best at is performing highly repetitive 
tasks at great speed with great accuracy. Learning a programming language 
such as C or Perl allows you to fully utilize the power of a computer, but 
becoming fluent in a programming language can take significant time and 
effort. With a fraction of that effort, however, it is possible to learn to use 
macros, regular expressions, simple scripting languages such as AppleScript, 
certain applications, Unix shell scripts and the Unix command line interface 
to automate repetitive tasks and save a great deal of time and effort.

Common Tasks that can be Automated
• Entering passwords ( Keychain Access, ssh )
• Filling out forms ( Safari or Internet Explorer AutoFill )
• Searching and reformatting files ( BBEdit, grep, regular expressions, shell scripts )
• Tabulating data in files ( BBEdit, grep, regular expressions )
• Renaming files ( File Buddy, Renamer4Mac, AppleScript, shell scripts ) 
• Entering repetitive information ( macros, AppleScript, shell scripts )
• Readback of repetitive information ( AppleScript )
• Assembly of repetitive information ( AppleScript, regular exp., shell scripts )
• Repetitive tasks ( cron, osascript, CronniX, shell scripts )
• Backups ( Retrospect, SuperDuper!, AppleScript, rsync, shell scripts )
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Automation Utilities 
in OS X or Unix

Macros
A macro is a single, user-defined command that executes a series of one or more commands.
• QuickSilver ( http://www.blacktree.com/ ) 
• Typeit4me  ( http://www.typeit4me.com/ )
• Keyboard Shortcuts ( System Preferences > Keyboard & Mouse > Keyboard Shortcuts > + )
• alias ( Unix shell command )

Renaming Utilities
• Renamer4Mac ( http://www.power4mac.com/renamer/ )
• File Buddy ( http://www.skytag.com/ ) Shareware

Backup Utilities
• rsync and RsyncX ( http://archive.macosxlabs.org/rsyncx/rsyncx.html )
• Retrospect ( http://www.dantz.com ) Commercial

Text Processing Utilities
• grep and regular expressions ( Unix utilities ) 
• BBEdit ( http://www.barebones.com/ )  Commercial (TextWrangler is free)

Scripting Languages
A scripting language is a simple language, typically written in a series of English-like statements that, 
when executed, sends commands to applications or to the operating system itself.
• AppleScript
• Automator
• bash Unix shell scripts
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Automating Chronological 
Tasks in OS X or Unix

Startup
It is possible to automatically launch applications (including AppleScripts) in OS X 
when the computer starts up by adding them to the Login Items tab of the 
Accounts pane under System Preferences.

cron
Cron is a Unix system service that allows for scheduled (daily, weekly or monthly) 
execution of scripts, programs and applications. The lists of scheduled actions are 
kept in a formatted text file called a crontab. There is a system crontab, which 
normally should not be edited, and a personal crontab for each user, which is what 
you should edit to add a regularly scheduled task. Cron can be used with rsync or 
RsyncX to create an automated backup system.
     By default, OS X 10.4 has a number of regular maintenance functions handled by 
another process called launchd, scheduled to run between 3:15 A.M. and 5:30 A.M. 
(which will not take place if the computer is shut off or asleep at that time).

CronniX
CronniX provides an OS X Aqua graphical user interface to cron, which makes 
editing crontabs to schedule repetitive tasks easier. It can be downloaded from the 
Mac OS X section of VersionTracker ( http://www.versiontracker.com/ ).

osascript
Osascript is a shell utility that allows you to run AppleScripts from the Unix 
command line (and thus use cron to run an AppleScript at scheduled intervals).
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Automator

Automator is an automation application introduced in OS X 10.4  (found 
in /Applications). It allows users to assemble a series of steps (called 
actions) into a single sequence (called a workflow), without any 
programming required. Instead, it uses a simple drag-and-drop graphical user 
interface. Once created, workflows can be saved, modified and run again.

To create a workflow that would read back entered text, you would launch 
Automator, select TextEdit (from the Library column), then use the Ask for 
Text action, followed by the Speak Text action. An Automator workflow can 
be saved as a workflow, application or plug in.
 
A number of predefined Finder and application actions are included (stored 
in /System/Library/Automator). Other actions can be added, and third-party 
applications can be written in such a way that their own actions 
automatically become available for use in Automator.

Behind the scenes, Automator uses the AppleScript scripting language to 
create and carry out its actions. Although Automator can be used to create 
useful workflows, more powerful scripting requires the use of a scripting 
language and techniques such as regular expressions.
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Automator in Bioinformatics

iNquiryXTE is an example of an Automator based bioinformatics application. It is an OS X Open 
Source application that functions both as a web services client to an iNquiry enabled Apple 
Workgroup Cluster and an Automator action generator.
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AppleScript

AppleScript
AppleScript is a scripting language that provides direct control of scriptable 
Macintosh applications, including many parts of the Mac OS itself. Instead of 
using a mouse or keyboard to manipulate applications, you create scripts to 
automate tasks, control applications on local or remote computers, and even 
to access web services. 

AppleScript allows scripters to extend and integrate features supplied by the 
operating system and by scriptable applications. To provide scripters with 
increased flexibility and power, developers make their applications scriptable, 
or capable of responding to Apple events. Applications can also execute 
scripts or send individual Apple events to take advantage of features of other 
applications. For example, a script that executes when the system boots 
could run a mail program, scan messages in the in box for URLs of a certain 
form, and then open those URLs in a web browser.
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AppleScripts
In AppleScript, users write a series of English-like statements or scripts, that, 
when executed, send commands to applications or to the Mac operating 
system itself. These scripts can be far more complex than Automator 
workflows. The following script will use the TextEdit application to say hello:

Script Editor
This script can be run from Script Editor (in /Applications/AppleScript), 
which is normally used to edit, test and run AppleScripts  Scripts can be 
saved as a text files, compiled scripts, run only compiled scripts or 
applications. 

Automating Macintosh OS X 
Applications with AppleScript

tell application "TextEdit"

 activate

 try

 
 set this_string to ("Hello world!") as string

 
 set default_voice to ("Ralph") as string

 
 say this_string using default_voice

 end try
end tell



Lecture 3
Macintosh OS X

and Unix
October 8, 2009

Regular Expressions

A regular expression is a pattern that describes a set of strings. Regular 
expressions are constructed analogously to arithmetic expressions, by using 
various operators to combine smaller expressions. 

Wildcards   
.
 A period matches any character except a line break (i.e. a carriage return).    
^
 A caret matches the beginning of a line (unless used in a character class).   
$
 A dollar sign matches the end of line (unless used in a character class).    

Character Classes
[...]	 To match a set of characters, place square brackets around them. [agct] will match 

an a, g, c or t.
[^...]	 To exclude a set of characters, place a caret after the opening bracket. [^agct] will 

not match an a, g, c or t, but will match any other character.
-	 To specify a range of characters, use a hyphen within the backets. [0-9] will match 

any digit.

Quantifiers
*	 An asterisk matches zero or more occurrences of the specified class or character that 

precedes it. .* will match no or any characters.
+	 A plus sign matches one or more occurrences of the specified class or character that 

precedes it. [0-9]+ will match at least one digit.

Escape Character
\	 A backslash acts as an escape character, allowing you to search for wildcard or special 

characters, e.g. \. will actually match a period, and \\ will match a backslash.
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Searching for Regular Expressions 
with grep

grep (Globally search for Regular Expression and Print)
Grep is a powerful Unix text searching utility that is available at both the command line in OS X 
and in certain applications such as TextWrangler or BBEdit, or in Window applications such as 
WindowsGrep. Grep can search the input for lines containing a match to a given pattern, using 
regular expressions if necessary, then output the lines that matched. Grep can thus greatly 
automate searching for information in text files. 

The Unix grep utility can be invoked from the Terminal in OS X using the following syntax:
grep -[options] 'pattern' filename(s)

Useful grep Options
-c	 print count of matching lines, rather than the matching lines themselves
-i	 ignore case distinctions in pattern and file(s)
-l	 print filenames containing matching lines, but not the matching lines

grep Results
grep normally prints a list of every line within the file(s) searched containing a match. 

In Terminal, typing grep 'RNA' sars.txt will find all lines containing RNA within the 
sars.txt file. To automatically output those lines to a file called sarsrna.txt, one would type 
grep 'RNA' sars.txt > sarsrna.txt (in Unix, > redirects output).

grep '>' sequences.fasta will return the name of every sequence in the 
sequences.fasta file (in a fasta file, the sequence name is on a line beginning with >).

grep -c '>' sequences.fasta will only return the number of sequences in the file.
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Searching for Regular Expressions 
with BBEdit and TextWrangler

Grep with BBEdit and TextWrangler
BBEdit and TextWrangler have a built-in grep utility which can be used through their Find & 
Replace function. To use it, simply make sure the Find & Replace Use Grep option is checked.

For example, to strip out all non-DNA characters (such as line numbers or spaces) from a text file  
containing a DNA sequence (such as r751.dna) in BBEdit or TextWrangler, one can simply enter 
[^acgt] in Search For, make sure Use Grep is checked, and Replace With nothing, then select 
Replace All (by default, it is case insensitive). 

To strip all numbering and blank spaces from a text file containing a protein sequence (such as 
gag.aa), one can first enter \d in Search For and Replace With nothing, then enter a space in 
Search For and Replace With nothing.

Useful BBEdit Special Character Matches

\r
 Line break (carriage return)    
\n
 Unix line break (line feed)    
\t
 Tab    
\f	 Page break (form feed)

\d
 Any digit [0-9]    
\D
 Any non-digit character (including carriage return)    

\s
 Any whitespace character (space, tab, carriage return, line feed, form feed)   
\S	 Any non-whitespace character (any character not included by \s) 
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Regular Expressions
 with Subpatterns 

Subpatterns
A subpattern consists of a simple or complex pattern enclosed in a pair of parentheses. 
Subpatterns allow you to reorder the data as it is replaced. This is a feature of certain grep 
implementations such as the one in TextWrangler or in the Perl programming language.

&	 The entire matched pattern (replacement only).
(x)	 The pattern x is remembered (search only).
\1, \2, ..., \99	 The nth subpattern in the entire search pattern.

If you have:	 You will get: 
ccc               Search For:    [acgt$]+	 Codon: ccc
gcg               Replace With: Codon: &	 Codon: gcg
atg	 Codon: atg
cga	 Codon: cga

If you have:	 You will get:
2152aa           Search For:       (\d)aa	 2152nt
623aa            Replace With: \1nt	 623nt
15aa	 15nt
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Startup Crashes
The computer freezes or crashes upon startup. This can be caused by 
hardware trouble, directory damage, or file damage.

Application Crashes
A specific application may freeze or crash intermittently without serious 
consequences. If an application keeps crashing consistently, there is a more 
serious problem.

Document Crashes
A specific document causes the application to crash when you try to open 
it. The application does not crash when opening other documents.

File Problems
A file cannot be deleted, is invisible, or otherwise misbehaves.

Volume Problems
A volume cannot be mounted, unmounted or ejected.

Macintosh OS X Troubleshooting: 
Potential Problems
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Startup Crash Recovery

Utilities
1) Run Disk Utility’s First Aid. Boot from the Mac OS X Install CD by holding down the C key 

while restarting with the CD in the computer to boot from the CD, then run the Disk Utility 
application from the CD to repair the disk and repair permissions.

2) Run DiskWarrior, a commercial utility that can potentially repair directory damage that Disk 
Utility cannot. Others recovery utilities include Data Rescue II, TechTool Pro and Drive 10.

Boot in Safe Mode
1) Hold down the Shift key while restarting the computer to start in Safe Mode. This will 

disable third party kernel extensions and startup items.

2) If booting in Safe Mode solves the problem, it is likely caused by a third-party startup item. 
Remove likely candidates (check System Preferences > Accounts > Login Items 
or /Library/StartupItems and /System/Library/StartupItems).

Zap the PRAM
To clear the computer’s parameter RAM and nonvolatile RAM, which contains certain system 
and device settings, hold down the Command Option P and R keys while restarting the 
computer.  Hold the keys down until the computer restarts twice.

Reinstall OS X
1) As a last measure, if you do not have a recent backup, you can use the Archive and Install 

option to reinstall OS X from the Mac OS X Install CD. 

2) If you have a current backup you are certain of, you can use Erase and Install instead.
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Understanding Startup Crashes

Console and Log Files
The Console application, located in /Applications/Utilities, lets you view log files (located 
at /Library/Logs/) which can contain useful information about the cause of a crash. Particularly 
useful log files to review using Console include console.log, system.log, any crash logs and 
panic.log (see below).

Automatic Kernel Panic Logging
Macintosh OS X 10.4 uses automatic kernel panic logging. You may or may not see any visual 
indication of a kernel panic. You should check the kernel panic log any time you had to force restart 
your computer, using either the power button, interrupt button, or the Control Command 
Power key combination. The kernel panic text is saved to a log file named panic.log and can 
contain useful information about the cause of the kernel panic, suggesting a possible solution. 

Verbose Mode
It is possible to start your computer up in Verbose mode by holding down Command and V at 
startup. This will display startup information that can potentially be useful in troubleshooting a 
problem.

Apple Startup Problems Guide
Apple has a detailed guide for resolving startup problems available at:
http://docs.info.apple.com/article.html?artnum=106805
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Causes of Application Freezes
Application freezes are typically caused by bugs in a program, a corrupt application preference 
file, a corrupt font file, a permissions problem, or a corrupted application.

Fixing Application Freezes
Force Quit by pressing Command Option Esc, or holding Option down while clicking 
on the application’s icon in the Dock. Then relaunch the application. Unlike OS 9 or Windows, 
there is no need to restart the computer, because memory is protected.

Fixing Recurring Application Crashes
1) Delete potentially corrupt application preference files. They will be recreated by the 

application the next time it is run. Look in ~/Library/Preferences or ~/Library/
Preferences/ByHost for preference files that belong to that application and delete 
them. You may also need to look in ~/Library/Application Support. 

2) Run Disk Utility and repair permissions.

3) Check for corrupt font files. Look in ~/Library/Fonts, /Library/Fonts, and /System 
Folder/Fonts.

4) Reinstall the application.

Application Crashes
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Causes of Document Crashes
Document crashes are typically caused by a corrupt document file.

Document Crash Recovery

1) Recover corrupted document from within application, if such an option 
exists.

2) Delete corrupted document and restore from a current backup/autosave.

3) Delete corrupted document and restore it from a recent backup.

4) Recover text from corrupted document with a utility such as 
CanOpener, BBEdit with CanOpener Text Extract, or MacLink Plus.

Document Crashes
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Undeleteable Files
1) Check locked status and permissions by selecting the file, then choosing Get Info 

(Command I) from the File menu. Locked files can be deleted from the Trash by holding 
down Command and Shift while emptying the Trash.

2) Check permissions by running Disk Utility’s First Aid.

3) Delete the file from the Unix command line. Launch the Terminal application. Type rm, 
followed by a space (“rm ”). Drag the file you want to delete to the Terminal window, then 
hit return. When done, type “exit” and hit return. If you need to delete a number of files in 
the Trash, they are located at “~/.Trash”. If you are deleting a folder or an application 
bundle, you will need to type rm -r.

4) If that still does not work, use the same approach, but type “sudo rm -ri ” at the beginning 
of the line, drag the file, then hit return. Type your password and hit return, then type “y” and 
hit return if correct, and when done type “exit” and hit return. Whenever working from the 
Unix command line be careful to be very precise, otherwise you may delete more then you expected.

Invisible Files
1) Files whose name begins with a “.” are automatically made invisible by OS X. This is a rare 

problem with downloaded files. Utilities such as XRay allow you to rename such files, 
otherwise you cannot use them.

2) Files can also have an Invisibility bit set on. XRay can be used to change an incorrectly set 
Invisibility bit.

3) OS X further keeps a special root level .hidden file which is a list of files that are meant to 
be kept invisible, typically system files which should not be altered.

File Problem Recovery
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Mounting Network Volumes
Various network volumes, including those from UNIX and Windows servers, can be mounted by 
selecting Connect to Server... from the Finder’s Go menu (Command K).

Ejecting/Unmounting Volumes
1) Drag the volume to the Trash (which changes into an Eject icon when a volume is selected and 

dragged).

2) Select the volume and select Eject (Command E) from the Finder’s File menu.

3) Click the the volume’s eject icon in the Sidebar. 

4) Holding down the Eject button (not just pressing it) ejects a CD or opens the CD drive.

Unejectable/Unmountable Volumes
1) If an error message comes up saying that the volume is “in use”, a file or application on that 

volume is open. Quit any applications that may be using documents or files on that volume.

2) Log Out from the Apple menu, then log back in.

3) Restart the computer and hold down the mouse button while it restarts to eject a CD.

4) Use a paper clip to manually eject the disk by pressing the manual release (typically a small hole 
near the drive opening).

Volume Problem Recovery
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Fixing Recurring Crashes
1) Select Log Out or Restart from the Apple menu.

2) If the Apple menu commands are not responding, press Control Command Eject to do 
a soft restart.

3) If that doesn’t work, press Control Command Power to do a hard restart.

4) You can force a shut down by holding down the power button for 5 seconds.

5) Try a hard reset by pressing and holding the Shift Control Option and Power keys (or 
pushing the reset button on older iBooks).

6) Run Disk Utility and repair permissions.

7) Try running Cache Out X to resolve potential cache problems.

8) Zap the PRAM and NVRAM (parameter RAM and nonvolatile RAM settings) by restarting 
the computer and holding down the Option Command P and R keys until the computer 
restarts for a second time (so that you hear the startup sound at least twice).

9) Reset the PMU (Power Management Unit) on the iBook by turning it off, disconnecting the 
power adapter, removing the battery, then press and hold Shift Control Option and 
Power for a second, then release (for older iBooks, press the reset button instead). After 
five seconds, reconnect the power adaptor, replace the battery, and turn the iBook back on. 
This will also reset the date and time.

10) Check troubleshooting web sites for a possible solution. 

11) Reinstall OS X.

Resolving Recurring Problems
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Recovering Deleted Files
Unix file systems (i.e. OS X) allow deleted files to be immediately overwritten, making it difficult or 
impossible to recover a file once you have emptied the Trash (particularly if you used Secure Empty 
Trash), which is why backups are critical. Certain utilities, such as Data Rescue II, may be able to 
recover deleted files, but are not guaranteed to work reliably.

Backup Strategies
1) Keep applications installed in the Applications directory, keep all of your documents and other 

files installed in your Home directory. This way, a backup of your Home directory will cover 
everything important.

2) Many applications have an Autosave option which will back up an application you are working on 
every few minutes. However, when making major changes, it is still wise to manually save a new 
version by selecting Save As... from the File menu of the application.

3) Regularly back up your Home directory by burning it onto a CD-R, copying it to another hard 
drive, or backing it up onto another backup device.

4) Back up critical files more regularly, including using Save As... to make a second copy, emailing 
them to yourself, or one of the above backup methods.

5) Backup utilities, such as Time Machine (free), rsync (free) or Restrospect (commercial), allow you 
to automatically schedule daily, weekly or monthly complete or incremental backups. 

6) Make a backup schedule and stick to it (i.e. CD-R home backup once a month, network backup 
once a week, critical file backup once a day).

7) Full backups that exactly duplicate your entire hard drive can be created and restored using Disk 
Utility, SuperDuper! or Time Machine (OS X 10.5 and up only) but require another volume of 
equal or larger size than the hard drive you are duplicating (e.g. an external FireWire hard drive).

Macintosh OS X Backup
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Books
Mac OS X Unleashed by John Ray & William C. Ray
Mac OS X Help Line by Ted Landau & Dan Frakes

Websites
http://www.info.apple.com
http://discussions.apple.com
http://www.macosxhints.com
http://fixa.troubledmac.com

Utilities
Data Rescue II (commercial) 
Disk Utility (free, located in /Applications/Utilities/Disk Utility)
DiskWarrior (commercial)
rsync (free, located in /usr/bin/rsync)
SuperDuper! (free)

(To download these and other utilities, search for them on
 http://www.versiontracker.com)

Troubleshooting References


